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Explore the history and geography of
the Klondike Gold Rush and Yukon Territory.
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Welcome to I7i
The Yukon Trail™

July 1897. The United Stat.
beginning to lose hope. Th
And the rush was on! Acre
thousands of people caugt
northwest Canada.

Version 1.x

Please do not make illegal copies of this software. The software you are
using was produced through the efforts of many people: designers,
artists, programmers, distributors, retailers, and other dedicated workers.
The costs of developing this and other software programs are recovered
through software sales. The unauthorized duplication of personal
software raises the costs to all legitimate users. This software is protected
by federal copyright law. Copying software for any reason other than to
make a backup is a violation of law. Individuals who make unauthorized
copies of software may be subject to civil and criminal penalties.

As a member of the Software Publishers Association (SPA), MECC
supports the industry's efforts to fight the illegal copying of personal
computer software. Report copyright violations to SPA, 1730 M Street
NW, Suite 700, Washington DC 20036-4510, 800/388-7478.
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ISBN 0-7929-0892-9 Printed in the U.S.A. November 1994 Getting Startei
MECC

6160 Summit Drive North
Minneapolis, Minnesota 55430-4003

Macintosh Installc

1. Lock each disk: pu

2. Insert Disk 1 into \
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5. Click on the "Insta

6. When the installat

Copyright © 1994 by MECC. All rights reserved. This software and
manual may not be copied or transferred in whole or in part except as
permitted by U.S. Copyright Law or as authorized in writing by MECC.
Macintosh is a registered trademark of Apple Computer, Inc. Windows is
a trademark of Microsoft Corporation. The MECC name is a registered
trademark of MECC. The Yukon Trail, For the Love of Learning, MECC's
Learning Guarantee, and the MECC logo are trademarks of MECC. All
other company and product names are trademarks or registered
trademarks of their respective owners.

Be sure to store your disks

For MECC Technical Support,
see page 4.
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The Yukon Trail

Welcome to The Yukon Trail
July 1897. The United States was in the throes of a depression, and people were

beginning to lose hope. Then, from out of the north, came astonishing news: GOLD!
And the rush was on! Across the United States, and indeed the world, tens of
thousands of people caught gold fever and set out for the remote Yukon area of
northwest Canada.

software you are
le: designers,
dedicated workers.
ims are recovered
of personal
iftware is protected
ason other than to
nake unauthorized
penalties.

As The Yukon Trail™ software program begins, you find yourself on the Seattle
wharf, jumping-off point for thousands of stampeders. There, and everywhere you go,
all kinds of people will have all kinds of advice for you. Be careful who you listen to!
Some people have valuable advice. Others don't know what they're talking about.
And still others are trying to rip you off. (By the way, the people who have both a first
name and a last name, like Ethel Berry, are actual historical figures. People with no
names or just first names are fictitious but are representative of the types of people
you might have encountered.)5PA), MECC

ing of personal
C 1730 M Street
478.

If you're smart, persistent, and just a little bit lucky, you'll make it to Dawson City,
headquarters of the gold rush. You'll get to talk to miners who have struck it rich, and
then you can set out on your own to dig for gold.

November 1994 Getting Started—Macintosh

Macintosh Installation

Lock each disk: push the tab so that you can see a hole in the disk.

Insert Disk 1 into your floppy drive. A new window appears, displaying an
icon called Installer.

Double-click on the Installer icon.

Make sure that the location indicated is where you want to install the
program. If it is not, change the location.

Click on the "Install" button and follow the on-screen instructions.

When the installation is done, the Yukon Trail application icon will appear.

1.

2.
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er, Inc. Windows is
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3.
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5.

6.

Be sure to store your disks in a safe place as a backup copy of the program.

3ft, Macintosh Start-up
• Double-click on the Yukon Trail icon.
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The Yukon Trail

Playing the GGetting Started—Windows

Windows Installation
We've tried to make the p
There's no compelling rea
of the window and click \

1. If Windows is not running, type WIN to start Windows.

2. Lock each disk: push the tab so that you can see a hole in the disk.

3. Insert Disk 1 into disk drive A (or B, if B is your only 3.5" disk drive).

4. In the Program Manager screen, choose Run from the File Menu. You see the
Run window.

5. Type A: \SETUP (or B: \SETUP) in the C_ommand Line box. Click on the
OK button.

If you get the message "Application Execution Error—Cannot find file," it
means that you forgot to enter the drive letter (A: or B:) or entered the wrong
letter.

If you get the message "System Error—cannot read from drive A:," you may
have a defective disk. Eject the disk and try installing again. If you get the
message again, try making a diskcopy of the disk (use the DOS "diskcopy"
command). If you get an error message, the disk is defective and needs to be

replaced. See "MECC Technical Support (MECCTECH)" on page 4.

6. Follow the on-screen instructions. When the installation is finished, you
return to Windows.

During the opening sequt
upper left corner of the w

• A book. This is yc
journal automatic
want. You can op
on the Game mer

• A moneybag. Wh
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Journal commanc
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For help with other progi

Apple menu (Macintosh)

Game Preferences
The Set Preferences comn
and sound effects and set

preferences, you need to
The password is MECC. I
options, change the passeBe sure to store your disks in a safe place as a backup copy of the program.

GamblingWindows Start-up

Double-click on the Games group.

Double-click on the Yukon Trail icon.

If the program doesn't take up most of the screen, you are running Windows
in a high-resolution mode. The program takes up more of the screen if you are
running in 640x480 mode. To change your Windows Setup, go to the Main
window and double-click on Windows Setup. If the display does not say
"640x480x256," go to the Options menu and select "Change System Setting."
Press the arrow next to the display window and pull down the settings list.
Scroll through the list to find "640x480x256" for your video card. Select it,

press OK, and restart your computer.

If you have trouble getting the sound to work, see the text file on Disk 1.

Gambling was omnipresi
The Yukon Trail. If you p
gambling by using the Se
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The Yukon Trail

Playing the Game
We've tried to make the program so easy to use that you won't need any instructions.
There's no compelling reason to use the menu commands; just point to different parts
of the window and click when you think something interesting might happen.

During the opening sequences of the program, you will see a couple of items in the
upper left corner of the window:

• A book. This is your journal. Sometimes, the program makes entries in your
journal automatically. You can also make your own entries whenever you
want. You can open your journal by using the See Outfit & Journal command
on the Game menu.

• A moneybag. Whenever you make a cash transaction, gold coins go into or
out of the bag. You can check your money supply by using the See Outfit &

Journal command.

idows.

ole in the disk.

.r 3.5" disk drive).

re File Menu. You see the J

Line box. Click on the

r—Cannot find file," it
B:) or entered the wrong

For help with other program operations, you can choose the Help command from the
Apple menu (Macintosh) or use the commands on the Help menu (Windows).from drive A:," you may

tg again. If you get the
ise the DOS "diskcopy"
defective and needs to be
ZH)" on page 4.

ition is finished, you

Game Preferences
The Set Preferences command on the Management menu allows you to disable music
and sound effects and set the unit of measure to English or metric. Before you can set
preferences, you need to use the Enable Management command to enter a password.
The password is MECC. If you want to prevent children from using the management
options, change the password and then use the Disable Management command.af the program.

Gambling
Gambling was omnipresent during the Yukon gold rush, and so it is a part of
The Yukon Trail. If you prefer not to expose your children to it, you can turn off
gambling by using the Set Preferences command on the Management menu.

ou are running Windows
ore of the screen if you are
s Setup, go to the Main
display does not say

'Change System Setting."
11 down the settings list.
ir video card. Select it,

The Yukon Trail vs. the Klondike Gold Rush

At MECC, we pride ourselves in producing entertaining, historically accurate
software programs. In The Yukon Trail, there is one aspect of the game that is
significantly different from what actually happened: the likelihood of finding gold. In
the real gold rush, the discovery was made in the fall of 1896. Because of the Yukon's
remoteness and cold climate, word of the discovery did not reach the outside world
until the summer of 1897 (when The Yukon Trail begins). By then, gold miners who
had been in the area at the time of the discovery had staked most of the good claims.
Of the more than 100,000 stampeders who set out for Dawson, fewer than half got

he text file on Disk 1.
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The Yukon Trail
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We would like to thank tf
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Marianne Mills (formerly
Historic Park, 117 South >
Peggy D'Orsay of Yukon .

Betsy Duncan-Clark and 1
P.O. Box 517, Skagway, A1

Russ and Winnie Kingma

Bruce Patnode, Klondike

Dave Neufeld, Yukon hist

Jim Cox and students at L

Steve Hoffmann, students

Shirley Glas, students, am

there; only half of those who reached Dawson searched for gold; only 4,000 found any
gold at all; and only a few hundred struck it rich. In The Yukon Trail, your odds of
finding gold are much better.

Learning More About the Yukon
There is a wealth of information about the gold rush. Much of it, however, is in books
that are hard to find. Fortunately, two of the best books are still relatively easy to get.
Both are written by Yukon native Pierre Berton. The Klondike Quest (Little, Brown and
Company, 1983) is a marvelous picture book with just the right amount of text to tell
the story of the gold rush. The Klondike Fever (Carroll & Graf Publishers, Inc., 1958) is a
definitive history.

You might also wish to contact the Klondike Gold Rush National Historic Park. It has
two locations: 117 South Main Street, Seattle, WA 98104 and P.O. Box 517, Skagway,
AK 99840.

MECC Learning Gua

MECC Technical Support (MECCTECH) Guaranteed learning. Gue
learning areas included ir
improvement as a result c
your money back. Simply
the store name and locatic

If you have a problem using this program, first check the Help command (Macintosh)

or the commands on the Help menu (Windows). If you can't find your answer there,
you can contact the MECC Technical Support group. Before you call:

• Note the name, product number, and version number of the software.

• Note the brand and model of the equipment involved.

• Please be in front of your computer when calling.

Call MECCTECH Line (Automated Support System) at 612/569-1678 to receive
answers to the most commonly asked technical questions about MECC products
24 hours a day, 7 days a week. The Automated Support System offers convenient fax-
back capability for technical tips.

Contact MECCTECH OnLine (First Class® Bulletin Board System) at 612/569-1769 to
receive an answer to your question(s) about MECC products or to receive product
information. You will need a modem to use this service.

Warranty and Licens
MECC warrants that this
computers. See the produ

For complete warranty an

Credits
The Yukon Trail was desij
consisting of Brian Ander
Dave Denninger, Martin I

John Hickman, Chad Iver
Dan Megears, Kevin W. N

Timothy Roseth, and Van;

The music was composedYou can speak with a Technical Support Representative by calling 612/569-1678
Monday-Friday from 8:00 A.M. to 5:30 P.M. Central Time.

You can write MECC Technical Support, 6160 Summit Drive North, Minneapolis, MN
55430-4003.
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The Yukon Trail
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MECC Learning Guarantee
Guaranteed learning. Guaranteed fun. We're so sure kids will improve in the key
learning areas included in this product that we guarantee it. If you don't see
improvement as a result of regular use of this software, we'll exchange it or give you
your money back. Simply return the complete package, along with a receipt showing
the store name and location, to MECC within 30 days.

Warranty and License Information
MECC warrants that this product will operate on appropriately configured
computers. See the product box for hardware and software requirements.

For complete warranty and license information, see the text file on Disk 1.

Credits
The Yukon Trail was designed and produced by a MECC development team
consisting of Brian Anderson, Glen Anderson, Ethy Cannon, Craig Copley,
Dave Denninger, Martin Euerle, Sandra Forslund, Mark Allen Hanson,

John Hickman, Chad Iverson, Sheila Kelly, Julie Redland Kmoch, Lon Koenig,
Dan Megears, Kevin W. Neff, Tom Naughton, Larry Phenow, Diane Portner,
Timothy Roseth, and Vang Thao.
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